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EXAM PREPARATION GUIDE

Adobe® Photoshop CS

This guide provides all the information you need to get started in 
preparing for Adobe Certified Expert (ACE) exams. Passing ACE exams 
demonstrates your proficiency with Adobe software products and 
allows you to promote your expertise with customers and employers. 
As an ACE, you can stand out from your competitors and be noticed.

ACE Frequently Asked Questions

What is an ACE? What are the benefits of being certified? What are the exams 
like? Get all your ACE questions answered in a brief, to-the-point FAQ.

Four–Step Check List

Learn about the process for getting certified.

Step 1:  Choose your certification level. 
Step 2: Register for your exam(s). 
Step 3:  Prepare for and take your exam(s). 
Step 4:  Read the ACE Agreement and join the Adobe Certified community. 

Exam Topic Areas and Objectives

Review the test content—topic areas and objectives—for each product exam. 
The topic lists will help direct your studies, so please review correctly.

Practice Exams

Review sample questions to get an idea of the types of questions that will 
be on the exam. Note: Though helpful, these practice exams are not necessarily 
representative of the difficulty of the questions that you will encounter on the  
actual exam.

Practice exams are available for all of the following Adobe products:

• Adobe® Acrobat® Professional 
• Adobe After Effects® 
• Adobe GoLive® 
• Adobe Illustrator® CS 
• Adobe InDesign® CS 
• Adobe Photoshop® CS 
• Adobe Premiere® Pro
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Q.  What is an Adobe Certified Expert (ACE)?

A.  An Adobe Certified Expert (ACE) has earned a certification created specifically 
for graphic designers, Web designers, video professionals, system integrators, 
value-added resellers, developers, or business professionals seeking recognition 
for their expertise with Adobe products. By passing one or more ACE exams, you 
become eligible to promote yourself to prospective clients as a highly skilled, 
expert-level user of Adobe software.

Q. What is the main benefit of passing ACE exams and becoming Adobe 
certified?

A. Adobe certification is an industry standard in excellence that can be used 
to demonstrate your product knowledge and expertise, and also serves as a 
catalyst when finding a job or seeking a promotion. The Adobe Certified Expert 
(ACE) and Adobe Certified Instructor (ACI) logos and credentials have been 
created for self-promotional use by individuals who have met all requirements 
of the Adobe certified Expert or Adobe Certified Instructor programs. Those who 
have passed the tests may place certification logos on business cards, resumes, 
Web sites, and other promotional materials.

Q.  What are ACE Specialist and ACE Master?

A.  There are three levels of Adobe certification. 

1.  Single product certification: Recognizes your proficiency in a single Adobe 
product. To qualify as an ACE, you must pass one product-specific exam. 
Example: ACE, Adobe InDesign® CS 

2.  Specialist certification: Recognizes your proficiency in a specific medium: 
Print, Web or Video. To become certified as a Specialist, you must pass the 
exams on the required products listed below. Example: ACE Print Specialist 
(with passing marks on the tests for Adobe InDesign, Adobe Acrobat®, and 
either Adobe Photoshop® or Adobe Illustrator®)

Specialists must pass all required (R) exams and any one elective (E) within any 
given certification track

Print Specialist Web Specialist Video Specialist

Adobe InDesign R — —

Adobe GoLive — R —

Adobe Acrobat R E —

Adobe Photoshop E R R

Adobe Illustrator E E —

Adobe Premiere® — — R

Adobe After Effects® — — R

Note: Exam requirements are subject to change. 

FREQUENTLY ASKED 
QUESTIONS
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3.  Master certification: Recognizes your skills in terms of how they align with 
the Adobe product suites. To become certified as a Master, you must pass 
the exam for each of the products in the suite. Example: ACE, Creative Suite 
Master (with passing marks on the tests for Adobe Acrobat, Adobe GoLive, 
Adobe Illustrator, Adobe InDesign, and Adobe Photoshop)

Q.  What is an Adobe Certified Instructor (ACI)?

A.  An Adobe Certified Instructor (ACI) is an ACE who provides instruction on Adobe 
products. ACIs must have an instructor qualification (a teaching credential, 
passed the CompTIA CTT+ (http://www.comptia.org/certification/ctt/) or 
equivalent), in addition to passing one or more ACE exams. For more information 
visit the ACI home page, http://www.adobe.com/support/certification/aci.html

Q.  How do I prepare for an ACE Exam?

A.  The keys to preparing for an ACE exam are experience with the product 
and studying this Exam Preparation Guide (http://partners.adobe.com/asn/
programs/trainingprovider/aceexams/index.jsp). To access online training, user 
guides, and many other study materials, visit Adobe’s training resources page 
(http://www.adobe.com/misc/training.html). The following resources may also 
help you prepare for your ACE exam:

•  Adobe product user guides

•  Adobe Press books

•  Adobe Authorized Training Centers (find the AATC nearest you through 
the Adobe Partner Finder online at: http://partners.adobe.com/asn/
partnerfinder/search_training.jsp) 

•  Adobe online training at www.adobe.elementk.com 

•  Tutorials and materials from Total Training, at www.totaltraining.com 

•  Other training resources online at www.adobe.com/misc/training.html

Q.  How do I get training?

A.  Once you know what product you want to get certified in, use the Adobe Partner 
Finder (http://partners.adobe.com/asn/partnerfinder/trainingprovider/index.
jsp) database to locate an Adobe Certified Instructor or an Adobe Authorized 
Training Center in your area that teaches a class on the Adobe product you want 
to learn. Contact them directly for more information about their classes and 
registration details.

Q.  What are the benefits to becoming an ACE?

A.  As an individual with an ACE, you can:

•  Differentiate yourself from competitors

•  Get your resumé noticed

•  Attract and win new business

•  Gain recognition from your employer

•  Get the inside track on Adobe’s latest offerings

•  Leverage the power of the Adobe brand and resources 

If you are an employer, use ACE as a benchmark so you can:

•  Find the right person for the job

•  Quickly assess candidate skill level

•  Invest in your most promising employees

•  Increase productivity and efficiency

FREQUENTLY ASKED 
QUESTIONS
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Q.  What type of exam are the ACE exams?

A.  Adobe ACE exams (which are administered by Pearson VUE and Thomson 
Prometric, independent third-party testing companies) are computer-delivered, 
closed-book tests consisting of 60 to 90 multiple-choice questions. Each exam 
takes approximately one to two hours to complete, and results are given to you 
at the testing center immediately after you complete the test. 

Q.  How do I register for an ACE exam?

A.  Contact Pearson VUE or Thomson Prometric by phone, on the Web, or in-person:

Pearson VUE Thomson Prometric

Register online www.pearsonvue.com www.2test.com

Register in-person Find a location online at 
www.pearsonvue.com

Find a location online at 
www.2test.com

Q.  What is the fee for the ACE exam?

A.  Each exam is US$150 or local currency equivalent.

Q.  Soon after I passed an ACE exam, the exam was published for a new 
product version. Do I have to successfully complete the new exam within 
90 days?

A.  No. You may continue to use the ACE logo and materials in accordance with the 
Adobe Certified Program Guidelines for Logos and Credentials. When the exam 
is published for the next version of the product you must successfully complete 
that exam within 90 days to keep your ACE status current and continue using the 
ACE logo and materials.

 For example, you successfully completed the Adobe Photoshop 5.0 Product 
Proficiency Exam; shortly thereafter, the Adobe Photoshop 6.0 Product 
Proficiency Exam is published. If you choose not take the Adobe Photoshop 6.0 
Exam, you may continue to use the ACE logo and materials. When the Photoshop 
7.0 Product Proficiency Exam is published you must successfully complete 
that exam with 90 days in order to continue to use the ACE logo and materials. 
Otherwise, you would have to cease using the ACE logo and materials; however, 
you could continue to use text references only to your Adobe Photoshop 5.0 
certification.

Q.  What can I expect from Adobe if I pass the ACE exam?

A.  As soon as you pass the exam, your name and exam results are given to us by 
Pearson VUE or Thomson Prometric, our worldwide test administrators. Your 
exam data is then entered into our database. You will then be sent an ACE 
Welcome Kit and access to the ACE logo. You are also placed on our certification 
mailing list to receive special Adobe announcements and information about 
promotions and events that take place throughout the year.

Q.  How long does it take to receive my Welcome Kit?

A.  You can expect your Welcome Kit to arrive four to six weeks after we receive 
your exam results.

FREQUENTLY ASKED 
QUESTIONS
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STEP 1: Choose your certification level

There are three levels of certification to become an Adobe® Certified Expert. 
Choose the one that’s right for you.

1.  Single product certification: Recognizes your proficiency in a single Adobe 
product. To qualify as an ACE, you must pass one product-specific exam. 

Example: ACE, Adobe InDesign® CS

2.  Specialist certification: Recognizes your proficiency in a specific medium: 
print, Web, or video. To become certified as a Specialist, you must pass the 
exams on the required products listed below. 

Example: ACE Print Specialist (with passing marks on the tests for Adobe 
InDesign, Adobe Acrobat®, and either Adobe Photoshop® or Adobe Illustrator®)

3.  Master certification: Recognizes your skills in terms of how they align with 
the Adobe product suites. To become certified as a Master, you must pass 
the exam for each of the products in the suite. 

Example: ACE, Creative Suite Master (with passing marks on the tests for 
Adobe Acrobat, Adobe GoLive®, Adobe Illustrator, Adobe InDesign, and Adobe 
Photoshop)

Specialists must pass all required (R) exams and any one elective (E) within any 
given certification track

Print Specialist Web Specialist Video Specialist

Adobe InDesign R — —

Adobe GoLive — R —

Adobe Acrobat R E —

Adobe Photoshop E R R

Adobe Illustrator E E —

Adobe Premiere® — — R

Adobe After Effects® — — R

Note: Exam requirements are subject to change. 

FOUR-STEP 
CHECK LIST

C E R T I F I E D  E X P E R T
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STEP 2: Register for your exam(s)

Adobe ACE exams are administered by Pearson VUE and Thomson Prometric, 
independent third-party testing companies. The tests are offered at more than 
five thousand authorized testing centers in many countries.

To register for your ACE exam(s), contact Pearson VUE or Thomson Prometric by 
phone, on the Web, or in person:

Pearson VUE Thomson Prometric

Register online www.pearsonvue.com www.2test.com

Register in-person Find a location online at 
www.pearsonvue.com

Find a location online at 
www.2test.com

The ACE exam fee is US$150 worldwide.

STEP 3: Prepare for and take your exam(s

The keys to preparing for an ACE exam are experience with the product and 
studying using the Exam Bulletin. To access online training, user guides, and 
many other study materials, visit Adobe’s training resources page.

The following resources may also help you prepare for your ACE exam:

• Adobe product user guides

•  Adobe Press books

•  Adobe Authorized Training Centers (find the AATC nearest you through the 
online Adobe Partner Finder)

•  Adobe online training from Element K (http://adobe.elementk.com)

•  Tutorials and materials from Total Training (http://www.totaltraining.com)

•  Other online training resources

ACE exams are computer-delivered, closed-book tests consisting of 60 to 90 
multiple-choice questions. Each exam takes one to two hours to complete, and 
results are given to you at the testing center immediately after you finish.

STEP 4: Sign the ACE Agreement and join the Adobe Certified community

Review the ACE Agreement prior to taking the exam. You will be asked to agree 
to the ACE terms and conditions at the time of the exam.

Once you are ACE certified, visit the Adobe Certified community where you can:

•  Verify exam results

•  Get a copy of the ACE Agreement

•  Download your Adobe Certified logo

•  Find out about recertification

•  Connect with other Adobe certificants

•  Update your profile

  Note: Information about the  Adobe Certified Community is also printed on your 
score report.

Recertify when necessary

Once obtained, your ACE certification is valid until 90 days after the exam 
version of your certification is retired. Adobe will e-mail you a reminder when 
your certification is due for renewal and will let you know when you need to take 
another ACE exam.

FOUR-STEP 
CHECK LIST
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EXAM TOPIC  
AREAS AND  
OBJECTIVES

Adobe® Photoshop CS

Test Content: Topic Areas and Objectives

Following is a detailed outline of the information covered on the exam.

1. Using the work area

•  Configure, save, and load workspaces.

•  Create a layer comp by using Layer Comps palette.

•  Manage libraries by using the Preset Manager.

•  Describe the functionality provided from the status bar and the tool options 
bar.

2. Importing, exporting, and saving

•  Import and manipulate files by using the Place command.

•  Import RAW files from a digital camera.

•  Given a file format, explain when you would use that format in Photoshop. 
(file formats include: PSD, PDF, TIFF, EPS, JPEG, GIF, PNG)

•  Explain when to rasterize and when not to rasterize vector data.

•  Describe the functionality provided by the File Browser.

3.  Working with selections

•  Given a scenario, choose the correct tool to create a selection.

•  Modify selections by using a tool or command.

•  Explain how feathering affects selections.

•  Explain how to work with Alpha channels to save or modify a selection.

•  Explain how to create and modify a temporary mask by using the Quick 
Mask command.

4.  Creating and using layers

•  Use the appropriate tools and commands to create and manage layers.

•  Edit layers by using the editing, vector, and painting tools.

•  Use the appropriate tools and commands to create and modify clipping 
masks, vector masks, layer masks, and layer sets.

•  Apply blending modes to layers and layer sets.

•  Create layer styles.

•  Given a mask, describe the functionality and when you would use the mask. 
(masks include vector and raster)

5.  Using channels

•  Given a channel, describe the channel, and explain when you would use it. 
(channels include: Alpha, color, and spot)

•  Explain how to create, manage, and use channels.
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6.  Managing color

•  Discuss the color management workflow process that is used in 
Adobe Photoshop. (topics include: ICC profiles, profiling devices, color 
management engine, color numbers)

•  Describe the difference between assigning and converting to ICC profiles.

•  Configure color settings by using the Color Settings dialog box.

•  Explain the purpose of and how to use the Proof Setup command.

•  Discuss the relationship between color gamut and rendering intents.

7.  Adjusting images

•  Analyze a histogram and explain changes that should be made to expand 
the dynamic range of an image.

•  Explain how to adjust the tonal range of an image by using an adjustment 
layer.

•  Explain how to adjust the tonal range of an image using options from the 
Image > Adjustments menu.

•  Given an option on the Auto Color Correction Options dialog box, explain 
the purpose of the option.

•  Discuss issues associated with changing the size and resolution of images.

•  Given an option on the Shadow/Highlight dialog box, explain the purpose 
of the option

8.  Drawing and editing

•  Create shape layers and paths by using the Pen and Shape tools.

•  Select and modify paths.

•  Save and export paths.

•  Transform paths by using the Transform tools.

9.  Painting

•  Paint objects by using a specific tool. (tools include: Brush, History Brush, Art 
History, Pencil, Eraser)

•  Given an option from the Brushes palette, explain the purpose of that 
option. (options include: tip shape, brush presets, shape dynamics, air 
brush)

•  Create and use patterns.

•  Create and use Gradients.

10.  Retouching

•  Modify an image by using filters. (filters include: Unsharp Mask, Gaussian 
Blur, Despeckle, Noise)

•  Retouch an image by using a specific tool. (tools include: Healing Brush, 
Patch, Color Replacement, Clone Stamp, Dodge, Burn)

11.  Digital camera and video support

•  List and describe the options provided by Camera Raw features.

•  Explain the functionality provided by having non-square pixel support.

EXAM TOPIC  
AREAS AND  
OBJECTIVES
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12.  Working with automation

•  Create an action by using options in the Actions palette.

•  Play an action by using the Batch command including using File Browser as 
the source.

•  Explain the use and options for commands from the Automate menu.

13.  Working with type

•  Given a palette, explain options for type used in Photoshop. (palettes 
include Character and Paragraph; options include kerning, justification, 
alignment, anti-aliasing, multilingual dictionaries)

•  Create, enter, and edit type by using a type tool (type tools include: 
Horizontal Type, Vertical Type, Horizontal Type Mask, Vertical Type Mask)

•  Create and modify text on a path.

14.  Outputting to print

•  Given a scenario, select and explain when to use a specific Print command. 
(Print commands include: Print One Copy, Print Preview, Print)

•  Describe the options available for outputting to print in the Output and 
Color management pop-up menus in the Print dialog box.

•  Discuss issues associated with printing duotones.

15.  Outputting for the Web

•  Given a scenario, choose the appropriate file format to optimize images for 
the Web.

•  Create transparent and matted images by using the Save for Web command.

•  Explain how slices can be used to optimize images for the Web. (options 
include: layer based, user based, linking slices for optimization)

EXAM TOPIC  
AREAS AND  
OBJECTIVES
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Adobe® Photoshop CS

1.2 Create a layer comp by using Layer Comps palette.

Which feature allows you to create, manage and view multiple versions of your 
document within a single file?

A.  Layer sets

B.  Layer comps

C.  History palette

D.  Alpha channels

Correct answer:  B

1.3 Manage libraries by using the Preset Manager.

In which location should you save a Style library so that the library appears in 
the Styles palette menu?

A.  Presets/Styles folder inside the Photoshop program folder

B.  Plugins/Styles folder inside the Photoshop program folder

C.  Anywhere within the Photoshop program folder

D.  Presets folder inside the Photoshop program folder

Correct answer:  A

3.2 Modify selections by using a tool or command.

You have made a color-based selection, but there are some stray pixels within 
the selection that were NOT selected. You want to check around selected pixels 
and add unselected pixels to the selection if the pixels fall within a specified 
range. Which command should you use?

A.  Select > Similar

B.  Select > Grow

C.  Select > Modify > Smooth

D.  Select > Modify > Expand

Correct answer:  C

3.4 Explain how to work with Alpha channels to save or modify a selection.

Which feature allows you to create and store masks to manipulate, isolate and 
protect specific parts of an image?

A.  Layers

B.  Alpha channels

C.  Layer comps

D.  Quick Mask

Correct answer:  B

PRACTICE EXAM

Try out these helpful practice 
questions to get a feel for 
the types of questions on the 
ACE exam, but please note 
that your performance here 
does not indicate how you’ll 
do on the actual exam. To 
fully prepare for the exam, 
closely review the topic areas 
and objectives in the Exam 
Bulletin in this guide.
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3.5 Explain how to create and modify a temporary mask by using the Quick 
Mask command.

You are working in Quick Mask mode. You want to create a semi-transparent area 
for an anti-aliased or feathered effect. What should you do? 

A.  Paint with white

B.  Paint with black

C.  Paint with gray

D.  Change the opacity of the Quick Mask

Correct answer:  C

4.1 Use the appropriate tools and commands to create and manage layers.

You have made a selection on a layer. You want to copy the pixels in the 
selection to a new layer, and you want the pixels to be in the exact location as in 
the original layer. What should you do?

A. Choose Layer > New > Layer via Copy

B. Using the Move tool, drag the selection to the New Layer icon in the Layers 
palette.

C. Click the New Layer icon in the Layers palette to automatically copy the 
selection to a new layer.

D. Copy the selection, create a new layer, paste the selection, then choose 
options from the Layer > Align Linked menu.

Correct answer:  A

4.2 Edit layers by using the editing, vector, and painting tools.

Which tool should you use to fix red eye in images?

A.  Color replacement

B.  Clone stamp

C.  Sponge

D.  Magic Eraser

Correct answer:  A

4.3 Use the appropriate tools and commands to create and modify clipping 
masks, vector masks, layer masks, and layer sets.

You want to mask out a portion of an image on a layer without permanently 
removing the pixels. You want the mask to have soft edges for a smooth 
transition with other layers. Which type of mask should you create?

A.  Quick mask

B.  Layer mask

C.  Vector mask

D.  Clipping mask

Correct answer:  B

PRACTICE EXAM



ADOBE PHOTOSHOP CS

Page 11

4.5 Create layer styles.

You are creating a layer style that you want to use for text. The layer style 
consists of a drop shadow and an inner bevel. You want the text to take on the 
color of the underlying image, rather than using the foreground color. What 
should you do?

A.  Set the Opacity to 0%

B.  Change the Blend mode to overlay

C.  Set the Fill Opacity to 0%.

D.  Add a Color Overlay with an opacity of 0%.

Correct answer:  C

5.2 Explain how to create, manage, and use channels.

You are creating a spot color channel. You want to simulate a transparent ink, 
such as a clear varnish, that completely reveals the inks underneath. Which 
option would you modify?

A.  Solidity

B.  Opacity

C.  Color

D.  Blend mode

Correct answer:  A

6.3 Configure color settings by using the Color Settings dialog box.

When using color management, which describes the color space of different 
devices in a workflow?

A.  Profiles

B.  Working spaces

C.  Color Engine

D.  Rendering Intent

Correct answer:  A

7.1 Analyze a histogram and explain changes that should be made to expand 
the dynamic range of an image by using a Levels adjustment layer.

You are using a Levels adjustment layer to expand the dynamic range of an 
image. What is the result of dragging the Black Input Level slider to 25?

A.  Values from 0 to 25 are mapped to 25, increasing contrast

B.  Values from 0 to 25 are mapped to 25, decreasing contrast

C.  Values from 0 to 25 are mapped to 0, increasing contrast

D.  Values from 0 to 25 are mapped to 0, decreasing contrast

Correct answer:  C

PRACTICE EXAM
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7.2 Explain how to adjust the tonal range of an image by using a Curves 
adjustment layer.

Which image adjustments command provides up to 14 control points for 
highlight, midtone and shadow adjustments for individual channels?

A.  Curves

B.  Levels

C.  Color Balance

D.  Brightness/Contrast

Correct answer:  A

 7.4 Given an option on the Auto Color Correction Options dialog box, explain 
the purpose of the option.

Which setting in the Auto Color Correction Options dialog box increases contrast 
while preserving color?

A.  Enhance Monochromatic Contrast

B.  Enhance Per Channel Contrast

C.  Find Dark & Light Colors

D.  Snap Neutral Midtones

Correct answer:  A

8.1 Create shape layers and paths by using the Pen and Shape tools.

Which tool should you use to draw a precise path around an object, clicking or 
clicking and dragging to place each point?

A.  Magnetic Lasso

B.  Custom Shape

C.  Freeform Pen

D.  Pen

Correct answer:  D

8.2 Select and modify paths.

You have drawn a path with the pen tool. You want to select a single point so 
that you can move the point. Which tool should you use? 

A.  Pen

B.  Move

C.  Direct Selection

D.  Path Selection

Correct answer:  C

PRACTICE EXAM
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8.3 Save and export paths.

You have created a path that you will use repeatedly in a logo for a client. You 
want to be able to quickly access and use this path from within any Photoshop 
file. What should you do?

A.  Save the path in the file in which it was created

B.  Export the path

C.  Define the path as a Custom Shape

D.  Define the path as a Style

Correct answer:  C

9.1 Paint objects by using a specific tool

Which tool lets you paint with stylized strokes, simulating the texture of painting 
with different colors and artistic styles?

A.  Art history brush

B.  History brush

C.  Airbrush

D.  Pattern stamp

Correct answer:  A

9.4 Create and use Gradients.

You want to create a gradient that contains randomly distributed colors within a 
range of colors that you specify. What should you do?

A.  Create a noise gradient

B.  Create a solid gradient and choose Restrict Colors

C.  Create a solid gradient and add additional color stops

D.  Choose the Dither option when you draw the gradient

Correct answer:  A

10.2 Retouch an image by using a specific tool. (tools include: Healing Brush, 
Patch, Color Replacement, Clone Stamp, Dodge, Burn)

You want to selectively lighten an area of your image to enhance the highlights. 
Which tool should you use?

A.  Dodge

B.  Color Replacement

C.  Sponge

D.  Sharpen

Correct answer:  A

11.2 List and describe the options provided by Camera Raw features.

Which option in the Camera Raw dialog box reduces grayscale noise?

A.  Tint

B.  Sharpness

C.  Luminance Smoothing

D.  Color Noise Reduction

Correct answer:  C

PRACTICE EXAM
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12.1 Create an action by using options in the Actions palette.

You are recording an action. During the playback of the action, you want to be 
able to perform a manual task that cannot be recorded. What should you do?

A.  Insert a stop at the point where the manual task will be performed

B.  Insert a menu item at the point where the manual task will be performed

C.  Set the Action Playback Options to Step by Step

D.  Set the Action Playback Options to Pause

Correct answer:  A

13.3 Create and modify text on a path.

You want to create text on a path so that the text orientation is parallel to the 
baseline. What should you do?

A.  Use the Horizontal type tool

B.  Use the Vertical type tool

C.  Enter the text, select all using the Type tool, and rotate.

D.  Enter the text, select the text using the Direct Selection tool, and rotate

Correct answer:  B

14.2 Describe the options available for outputting to print in the Output and 
Color management pop-up menus in the Print dialog box.

While printing, you want to reduce the jagged appearance of a low-resolution 
image by automatically resampling up. Which option should you choose?

A.  Interpolation

B.  Anti-aliasing

C.  Screen

D.  Transfer

Correct answer:  A

15.3 Explain how slices can be used to optimize images for the Web. (options 
include: layer based, user based, linking slices for optimization)

Which feature should you use to assign multiple optimization settings to a single 
Web image, so that flat areas of color can have a different optimization setting 
than continuous tone areas?

A.  Slices

B.  Image maps

C.  Rollovers

D.  Data Sets

Correct answer:  A

PRACTICE EXAM
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